
VMware ESXi環境でのインストール

仮想マシンの基本的な作成と管理を可能にするハイパーバイザである VMware ESXiは、Cisco
Catalyst 8000Vによってサポートされるハイパーバイザの 1つです。このハイパーバイザは、
仮想化拡張機能を含むx86ハードウェア上で動作します。同じハイパーバイザを使用して複数
の VMを同時に実行できます。

Cisco IOS XE 17.12.1リリース以降、Cisco Catalyst 8000Vは、VMware ESXi 7.0.x上の Intel x550
NICを搭載した Intel Atom® C3000プロセッサ（Denverton）CPUベースのサーバーでサポート
されます。異なるバージョンのハイパーバイザオペレーティングシステムを使用する他のx86
CPUで Cisco Catalyst 8000Vを実行できますが、サポートはVMware ESXi 7.0.xでのみ使用でき
ます。

この章では、ESXiでの Cisco Catalyst 8000Vの展開方法と、展開を成功させるための要件につ
いて説明します。要件と展開手順を読む前に、ESXiハイパーバイザのさまざまな展開方法を
示す次の情報を参照してください。

ホストリソースのオーバーサブスクリプションは、パフォーマンスの低下につながり、インス

タンスが不安定になる可能性があります。ホストハイパーバイザに関するガイドラインとベス

トプラクティスに従うことを推奨します。

注意

VMに OVAテンプレートを展開します。

OVAファイルを使用した展開：この方法では、ソフトウェアダウンロードページから .ova
ファイルをダウンロードし、このファイルを展開に使用する必要があります。さらに、次の 2
つの方法を使用して OVAファイルを展開できます。

• vSphereクライアントを使用した展開：この手順では、VMware vSphereクライアントまた
は vSphere Webクライアントを使用して *.ovaインストールファイルを展開する必要があ
ります。VMware vSphere Webクライアントは、仮想拡張を含む x86ハードウェア上で実
行され、VMware vCenterサーバーにアクセスするWebアプリケーションです。VMware
vSphere Webクライアントソフトウェアを使用して、VMware vCenterサーバー上で VMを
作成、設定、管理したり、CiscoCatalyst 8000Vインスタンスを起動または停止したりする
ことができます。
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Cisco Catalyst 8000Vの展開にはこの方法を推奨します。（注）

•共通OVFツール（COT）を使用した展開：COTは、Cisco Catalyst 8000Vなどの仮想アプ
ライアンスを編集できるツールです。このツールを使用して、.ovaファイルを ESXiサー
バーに展開し、VMをプロビジョニングすることもできます。

VMware vSphere製品の詳細については、VMware製品のマニュアルを参照してください。

.ISOファイルの手動展開

ESXiハイパーバイザの 3番目の展開オプションは、.isoファイルを使用したVMの手動作成と
Cisco Catalyst 8000Vのインストールです。シスコのソフトウェアダウンロードページから .iso
ファイルをダウンロードし、このファイルをインストールに使用します。この方法では、

VMware ESXiホストに .isoファイルをインストールし、vSphere GUIを使用して手動で VMを
作成します。このオプションは、OVAを変更する場合にのみ使用することをお勧めします。
ただし、手動展開ではサポートされている設定から逸脱する可能性があるため、このオプショ

ンは推奨されません。

ESXi 6.5以降を使用して VMを作成します。VMバージョン 13以降を使用していることを確
認します。EFIファームウェアモードを選択するには、[VMOptions] > [BootOptions] > [Firmware]
> [EFI]の順に移動します。セキュアブート機能を有効にするには、このファームウェアモード
を選択する必要があります。詳細については、VNFセキュアブートの有効化を参照してくださ
い。

重要

VMの作成後にファームウェアモードを（BIOSからEFI、またはその逆に）変更することはで
きません。

重要

• VMware要件（2ページ）
•サポートされている VMware機能と操作（5ページ）
• vSphereを使用した VMへの OVAの展開（9ページ）
• COTを使用した VMへの OVAの展開（12ページ）
• .isoファイルを使用した VMの手動作成（18ページ）
• VMware ESXi構成でのパフォーマンスの向上（20ページ）

VMware要件
次の表に、Cisco IOS XE 17.4.1以降のリリースを使用する Cisco Catalyst 8000Vでサポートされ
るVMwareツールを示します。これらのバージョンは完全にテスト済みで、パフォーマンスベ
ンチマークに適合しています。
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vCenter ServervSphere Web ClientCisco IOS XEリリース

VMware ESXi 7.0VMware vSphere Webクライア
ントのバージョン 7.0および
6.7がサポートされています。

Cisco IOS XE 17.15.1リリース

VMware ESXi 7.0および ESXi
6.7

VMware vSphere Webクライア
ントのバージョン 7.0および
6.7がサポートされています。

Cisco IOS XE 17.14.xリリース

Cisco IOS XE 17.13.xリリース

Cisco IOS XE 17.12.xリリース

Cisco IOS XE 17.11.xリリース

Cisco IOS XE 17.10.xリリース

Cisco IOS XE 17.9.xリリース

Cisco IOS XE 17.8.xリリース

Cisco IOS XE 17.7.xリリース

Cisco IOS XE 17.6.xリリース

VMware ESXi 6.7および ESXi
6.5

VMware vSphere Webクライア
ントのバージョン 6.7および
6.5がサポートされています。

Cisco IOS XE 17.5.xリリース

VMware ESXi 6.7および ESXi
6.5

VMware vSphere Webクライア
ントのバージョン 6.7および
6.5がサポートされています。

Cisco IOS XE 17.4.xリリース

ESXiサーバーの管理にスタンドアロンのvSphereクライアントを使用しないでください。ESXi
6.0以降では、OVAを展開する場合、Cisco Catalyst 8000Vを ESXiに直接展開することはでき
なくなりました。.ovaファイルを展開するには、vMware vCenterサーバーと vSphereクライア
ントが必要です。

（注）

• vCPU：次の vCPU設定がサポートされています。

• 1 vCPU：最低 4 GBの RAM割り当てが必要

• 2 vCPU：最低 4 GBの RAM割り当てが必要

• 4 vCPU：最低 4 GBの RAM割り当てが必要

• 8 vCPU：最低 4 GBの RAM割り当てが必要

• 16 vCPU：最低 8GBのRAM割り当てが必要（Cisco IOSXE17.11.1a以降でサポート）
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必要な vCPU設定は、インストールされているスループットライ
センスとテクノロジーパッケージによって異なります。詳細につ

いては、使用中のリリースのデータシートを参照してください。

（注）

•仮想ネットワークインターフェイスカード（vNIC）：最大 8つの vNICがサポートされ
ます。次の vNICがサポートされています。

• VMXNET3：Cisco IOS XE 17.4.1以降でサポート

• iXGBeVF：Cisco IOS XE 17.4.1以降でサポート

• i40eVF：Cisco IOS XE 17.4.1から Cisco IOS XE 17.8.xでサポート

• iavf：Cisco IOS XE 17.9.1以降でサポート

• ConnectX-5VF：Cisco IOS XE 17.9.1以降でサポート

• ixgbe：Cisco IOS XE 17.10.1以降でサポート

• VMware vCenter：インストールツール

• VMware vSwitch：標準または分散型の vSwitchがサポートされています

•ハードドライブ：単一のハードディスクドライブのみがサポートされています。1台の
VM上で複数のハードディスクドライブはサポートされません

•仮想ディスク：16 GBと 8 GB両方の仮想ディスクがサポートされています

• ESXiハイパーバイザ：サポートされているバージョンについては、このセクションの表
を参照してください

•仮想 CPUコア：1つの仮想 CPUコアが必要です。これには、ホストマシンの BIOSセッ
トアップで仮想化テクノロジー（VT）が有効にされた 64ビットプロセッサが必要です。

•仮想ハードディスク領域：最小サイズは 8 GBです

•このインストールには、デフォルトのビデオ、SCSIコントローラセット、およびインス
トール済みの仮想 CD / DVDドライブも必要です。

サポートされているNICドライバのバージョンとファームウェアのバージョンは、ハイパーバ
イザパッケージに含まれているデフォルトのバージョンです。

（注）

インストールを進める前に、セキュアブート設定についてよく理解しておいてください。セ

キュアブートの詳細については、VNFセキュアブートの有効化を参照してください。
ヒント
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サポートされている VMware機能と操作
VMwareでは、仮想アプリケーションを管理したり、複製、移行、シャットダウン、復帰など
の操作を実行したりするためのさまざまな機能と操作がサポートされています。

これらの操作の一部では、VMの実行時状態が保存され、再起動時に復元されます。ランタイ
ム状態にトラフィック関連の状態が含まれている場合、ランタイム状態を再開または再生する

と、追加のエラー、統計情報、またはメッセージがユーザーのコンソールに表示されます。設

定のみに基づいて回復される保存状態の場合は、これらの機能と動作を問題なく使用できま

す。

「サポートされている VMware機能と操作：ストレージオプション（vCenter Serverと vSphere
Clientの両方）」の表に、Cisco Catalyst 8000Vでサポートされる VMwareの機能と操作を示し
ます。VMwareの機能と操作の詳細については、VMwareのマニュアルを参照してください。

Cisco Catalyst 8000Vのすべてのバージョンで次のVMware機能および動作はサポートされてい
ませんが、パケットのドロップ、接続の切断、およびその他のエラー統計が発生するリスクを

承知の上であれば、サポート対象外のバージョンでも使用および実行できます。

•分散リソーススケジューリング（DRS）

•耐障害性

•再開

•スナップショット

•一時停止

一般的な機能（vCenterサーバー）
表 1 :サポートされている VMware機能および操作：一般機能（vCenter Serverのみ）

説明サポートされているエンティ

ティ

仮想マシンまたはテンプレートを複製したり、仮想マシンをテンプレートに複製し

たりできます。

複製

データストレージがまだ共有ストレージの同じ場所にある間でも、仮想マシンの状

態全体および必要に応じた設定ファイルが新しいホストに移動されます。

移行

VMの実行中に、ある物理サーバから別の物理サーバに VMを移動できます。VMotion

テンプレートを仮想マシンとして複製することにより、テンプレートを使用して新

しい仮想マシンを作成します。

テンプレート
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操作（vCenterサーバーおよび vSphere Webクライアントの場合）
表 2 :サポートされている VMware機能と操作：操作（vCenter Serverおよび vSphere Clientの場合）

説明サポートされているエン

ティティ

仮想マシンの電源を投入し、ゲストオペレーティングシステムがインストールされてい

ればゲストオペレーティングシステムをブートします。

電源オン

電源が再度オンになるまで仮想マシンを停止します。電源オフオプションは、「強制」

電源オフを行います。これは、物理マシンの電源コードを引き抜くことに相当し、常に

機能します。

電源オフ

シャットダウン（「安全な」電源オフ）は、VMwareツールを使用してゲストオペレー
ティングシステムのグレースフルシャットダウンを実行します。特定の状況（VMware
ツールがインストールされていない場合や、ゲストオペレーティングシステムが停止し

ている場合など）では、正常にシャットダウンできないことがあり、電源オフオプショ

ンを使用する必要があります。

シャットダウン

仮想マシンを一時停止します。一時停止

仮想マシンを停止し、再起動（リブート）します。リセット/再起動

ディレクトリ内の複数のファイルで構成されるOVFパッケージは、圧縮形式で保存され
たディスクファイルを含む仮想マシンの状態をキャプチャします。OVFパッケージを
ローカルコンピュータにエクスポートできます。

OVFの作成

OVFパッケージ/テンプレートから 1つの OVAパッケージファイルを作成できます。そ
うすると、OVAの配布が容易になります。たとえば、Webサイトからダウンロードした
り、USBキーを介して移動したりすることができます。

OVAの作成

表 3 :サポートされている VMware機能と操作：ネットワーク機能

説明サポートされているエン

ティティ

vCenter Serverと vSphere Clientの両方から。仮想ネットワークアダプタのMACアドレス
を手動で設定できます。

カスタムMACアドレス

vCenter Serverからのみ。vCenter Serverデータセンター上の 1台の vSphere分散型スイッ
チで、データセンターのすべての関連ホストに対するネットワークトラフィックを処理で

きます。

分散 VSwitch

ホスト間の自動ロードバランシングを提供します。分散リソーススケジュー

ラ
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説明サポートされているエン

ティティ

vCenter Serverと vSphere Clientの両方から。ロードバランシングポリシーとフェールオー
バーポリシーにより、アダプタが故障した場合に、アダプタ間でネットワークトラフィッ

クを分散する方法と、トラフィックを再ルーティングする方法を指定できます。

NICロードバランシング

vCenter Serverと vSphere Clientの両方から。各仮想スイッチが NICチームを形作る 2個の
アップリンクアダプタに接続する環境をセットアップできます。これにより、NICチー
ムでは、メンバーの一部または全体をまたがって、物理ネットワークと仮想ネットワーク

間のトラフィックの負荷を共有するか、ハードウェア障害やネットワーク障害の発生時に

パッシブフェールオーバーを提供します。

NICチーミングにより、多数の ARPパケットが Cisco Catalyst 8000Vにフラッディ
ングし、CPUが過負荷になるおそれがあります。この状況を回避するには、ARP
パケットの数を減らし、アクティブ-アクティブではなく、アクティブ-スタンバイ
として NICチーミングを実装します。

（注）

NICチーミング

vCenter Serverと vSphere Clientの両方から。vSwitchはレイヤ 2物理スイッチの仮想化バー
ジョンです。vSwitchでは、仮想マシン間でトラフィックを内部的にルーティングでき、
外部ネットワークにリンクできます。vSwitchを使用すると、複数ネットワークアダプタ
の帯域幅を組み合わせ、このアダプタ間で通信トラフィックを分散できます。物理 NIC
フェールオーバーを処理するように vSwitchを設定することもできます。

vSwitch

ハイアベイラビリティ

Cisco IOSベースの高可用性は、Cisco Catalyst 8000Vインスタンスではサポートされていませ
ん。高可用性は、VMホストでのみサポートされます。

（注）

表 4 :サポートされている VMware機能および操作：ハイアベイラビリティ

説明サポートされているエンティティ

オペレーティングシステムの障害をモニタするために、

VMレベルのハイアベイラビリティでは、VMwareハイア
ベイラビリティクラスタのハートビート情報をモニタし

ます。ユーザ指定の間隔までに、指定した仮想マシンから

ハートビートが受信されていないと、障害が検出されま

す。VMレベルのハイアベイラビリティは、VMware
vCenter Serverを使用して VMのリソースプールを作成す
ることによって有効化されます。

VMレベルのハイアベイラビリティ
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説明サポートされているエンティティ

物理サーバをモニタするために各サーバ上のエージェント

では、ハートビートが失われたときに、リソースプール

内の他のサーバにある影響を受けるすべての仮想マシンの

再起動を自動的に開始できるように、リソースプール内

の他のサーバとのハートビートを維持します。ホストレ

ベルのハイアベイラビリティは、サーバまたはホストの

リソースプールを作成し、vSphereでハイアベイラビリ
ティをイネーブルにすることによってイネーブルになりま

す。

ホストレベルのハイアベイラビリティ

ハイアベイラビリティを使用することで、ESXiホストの
耐障害性が有効になります。CiscoCatalyst 8000Vルータを
実行するVMの耐障害性を有効にすると、クラスタ内の別
のホストにセカンダリVMが作成されます。プライマリホ
ストが停止すると、セカンダリホストの VMが Cisco
Catalyst 8000Vのプライマリ VMを引き継ぎます。

耐障害性

ストレージオプション（vCenterサーバーおよび vSphere Webクライア
ントの場合）

表 5 :サポートされている VMware機能と操作：ストレージオプション（vCenter Serverと vSphere Clientの両方）

説明サポートされているエンティティ

ストレージオプション（vCenter Serverおよび vSphereClient
の両方）

ローカルストレージは ESXiホスト内にある内部ハード
ディスクにあります。ローカルストレージデバイスは複

数ホストにまたがる共有をサポートしません。ローカル

ストレージデバイス上のデータストアは 1台のホストに
よってのみアクセスできます。

ローカルストレージ

外部ストレージに Cisco Catalyst 8000Vインスタンスを展
開できます。この外部ストレージとは、ストレージエリ

アネットワーク（SAN）のことです。

外部ストレージターゲット
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説明サポートされているエンティティ

CiscoCatalyst 8000VにUSBスティックを接続し、ストレー
ジデバイスとして使用できます。ESXiでは、USBコント
ローラを追加し、CiscoCatalyst 8000Vにディスクデバイス
を割り当てる必要があります。

• CiscoCatalyst 8000Vはホットプラグをサポートしてい
ます。

•一度に使用できる USBディスクのホットプラグ対応
デバイスは、2台のみです。

• USBハブはサポートされていません。

USBストレージのマウントまたはパススルー

vSphereを使用した VMへの OVAの展開
Cisco Catalyst 8000V OVAファイルパッケージを使用して、Cisco Catalyst 8000VをVMに展開
できます。OVAパッケージには、Cisco IOS XEリリースとサポート対象のハイパーバイザに
基づいたデフォルトの VM設定が入っている OVFファイルが含まれています。

制限事項および要件

OVAパッケージを VMに展開する場合は、次の制限事項が適用されます。

仮想 CPU設定を変更した場合は、Cisco Catalyst 8000Vインスタンスをリブートする必要があ
ります。RAM割り当ての変更では、Cisco Catalyst 8000Vインスタンスをリブートする必要は
ありません。

OVAパッケージには、仮想 CPU設定を選択するオプションがあります。

OVAを展開する場合、VMには、OVF環境ファイル用に 1台と .isoファイル用に 1台の合計
2台の仮想 CD/DVDドライブが必要です。

VMへの OVAの展開
VMware vSphereクライアントで次の手順を実行します。

ステップ 1 VMware vSphere Clientにログインします。

ステップ 2 [vSphere Client]メニューバーから、[File] > [Deploy OVF Template]を選択します。

ステップ 3 OVAウィザードで、展開する Cisco Catalyst 8000V OVAの送信元を指定します。[Next]をクリックしま
す。

OVAに関する情報を示す [OVF Template Details]が表示されます。[Next]をクリックします。
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ステップ 4 [Name and Inventory Location]で、VMの名前を指定し、[Next]をクリックします。

ステップ 5 [DeploymentConfiguration]で、ドロップダウンメニューから必要なハードウェア設定プロファイルを選択
し、[Next]をクリックします。

ステップ 6 [Storage]で、VMに使用するデータストアを選択します。[Next]をクリックします。

ステップ 7 [Disk Format]で、ディスクフォーマットのオプションを選択します。

• Thick Provision Lazy Zeroed

• Thick Provision Eager Zeroed

[Thin Provision]オプションはサポートされていません。[Thick Provision Eager Zeroed]オプション
を指定すると、インストールに時間がかかりますが、優れたパフォーマンスを得られます。

（注）

[Next]をクリックします。

ステップ 8 [NetworkMapping]で、ドロップダウンリストを使用して、宛先ネットワーク上に 1つ以上の仮想ネット
ワークインターフェイスカード（vNIC）を割り当てます。

OVAの展開時に作成された 3つのデフォルト vNICのネットワークマッピングを選択します。ブートス
トラッププロパティを設定するときに、ルータの管理インターフェイスにマッピングするvNICを選択で
きます。

ブートストラッププロパティを変更すると、システムはユーザーが新規の VMを開始しようとし
ていると判断します。そのため、VMを再起動すると、既存のネットワーキング設定がすべて削
除されます。

（注）

ステップ 9 [Power On]時に接続する vNICを選択します。[Next]をクリックします。

OVAテンプレートを使用した Cisco Catalyst 8000Vのインストールが完了すると、追加の 2つの vNICが
割り当てられます。Cisco Catalyst 8000Vは最大 10の vNICをサポートします。VMで追加の vNICを手
動で作成する必要があります。

ステップ 10 VMのプロパティを設定します。

ブートストラッププロパティを変更すると、システムはユーザーが新規の VMを開始しようとし
ていると判断します。そのため、VMを再起動すると、既存のネットワーキング設定がすべて削
除されます。

（注）

VM作成時のブートストラッププロパティはオプションです。これらのプロパティを設定して、
起動する前の VMを簡単にプロビジョニングできます。

（注）

表 6 : OVAブートストラップのプロパティ

説明プロパティ

ブートストラップのプロパティ

コンソールモードを設定します。

設定可能な値：virtual、serial

コンソール

ルータのログインユーザー名を設定します。Login Username

VMware ESXi環境でのインストール
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説明プロパティ

ルータのログインパスワードを設定します。ログインパスワード（Login
Password）

Cisco Catalyst 8000Vインスタンスの管理インターフェイスを指定します。形式
は GigabitEthernetxまたは GigabitEthernetx.xxxである必要があります。

GigabitEthernet0インターフェイスはサポートされなくなりました。（注）

管理インターフェイス

dot1QVLANインターフェイスを設定します。GigabitEthernetx.xxx形式を使用し
て管理インターフェイスを設定する必要があります。

管理 vVLAN

管理インターフェイスの IPv4アドレスとサブネットマスクを設定します。管理インターフェイス IPv4アドレス/
マスク

IPv4管理デフォルトゲートウェイアドレスを設定します。DHCPを使用する場
合は、フィールドに「dhcp」と入力します。

Management IPv4 Default Gateway

IPv4管理デフォルトゲートウェイアドレスを設定します。DHCPを使用する場
合は、フィールドに「dhcp」と入力します。

管理 IPv4ゲートウェイ

管理ゲートウェイがルーティングする IPv4ネットワーク（「192.168.2.0/24」や
「192.168.2.0255.255.255.0」など）を設定します。デフォルトルート（0.0.0.0/0）
が必要な場合は、空白のままにすることができます。

管理 IPv4ネットワーク

Cisco Prime Network Services Controllerの IPアドレスを設定します。

この設定は、Cisco Prime Network Services Controllerを使用して Cisco Catalyst
8000Vインスタンスをリモートで管理する場合に使用されます。

PNSC IPv4アドレス

ルータのホスト名を設定します。ルータ名

リソーステンプレートを設定します。

設定可能な値：default、service_plane_medium、service_plane_heavy

リソーステンプレート

機能

IOS SCP機能を有効にします。SCPサーバーの有効化

SSHを使用したリモートログインを有効にし、Telnetを介したリモートログイ
ンを無効にします。ログインユーザー名とパスワードを設定する必要がありま

す。

SSHログインの有効化と Telnetログ
インの無効化

追加の設定プロパティ

特権（有効化）アクセス用のパスワードを設定します。Enable Password

ネットワークドメイン名を設定します。Domain Name

VMware ESXi環境でのインストール
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説明プロパティ

Cisco Catalyst 8000Vインスタンスの起動時に使用可能なライセンステクノロ
ジーレベルを設定します。使用可能なライセンスレベルは次のとおりです。

• network-essentials

• network-advantage

• network-premier

Cisco DNAライセンスの詳細については、『Cisco DNA Software for
SD-WAN and Routing』を参照してください。

（注）

License Boot Level

ルータプロパティの設定を完了したら、[Next]をクリックします。テンプレートを展開するときに使用
される設定を示す [Ready to Complete]画面が表示されます。

ルータのブート後に、詳細プロパティも設定できます。

ステップ 11 VMの電源を自動的にオンにするには、[Power On After Deployment]を選択します。

ステップ 12 [Finish]をクリックして OVAを展開します。

OVAにより .isoファイルが展開され、[Power On After Deployment]設定が選択されている場合は VMの
電源が自動的にオンになります。VMの電源がオンになると、Cisco Catalyst 8000Vデバイスによりイン
ストールおよび起動プロセスが開始されます。ブートストラップ設定ファイルがOVAに含まれている場
合は、ルータ設定が自動的に有効化されます。

詳細については、「Booting the Cisco Catalyst 8000V and Accessing the Console」を参照してください。

COTを使用した VMへの OVAの展開
Cisco Catalyst 8000V OVAファイルパッケージを使用して、Cisco Catalyst 8000VをVMに展開
できます。OVAパッケージには、Cisco IOS XEリリースとサポート対象のハイパーバイザに
基づいたデフォルトのVM設定が入っているOVFファイルが含まれています。VMwarevSphere
または COTまたは共通 OVFツールを使用して OVAを展開できます。このセクションでは、
COTを使用した展開方法について説明します。

共通 OVFツールは、1つ以上の VMの属性を作成し、Cisco Catalyst 8000Vソフトウェアをプ
レインストールしてVMを迅速に展開できる、Cisco Catalyst 8000Vソフトウェアパッケージに
含まれるLinuxベースのアプリケーションです。このツールを使用すると、複数のVMにCisco
Catalyst 8000Vを展開するプロセスを高速化できます。

COTは、.ovaファイルにVMの属性を入力するためのシンプルなコマンドラインインターフェ
イスを提供します。COTは LinuxシェルとMac OS Xのどちらでも実行できます。ただし、
VMware OVFツールがインストールされていることを確認してください。
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共通 OVFツール（COT）は、シスコの正式なサポートなしで提供されます。自己責任で使用
してください。

危険

COTのダウンロード
http://cot.readthedocs.io/en/latest/installation.htmlGitHubサイトに示されている手順に従って、COT
ライブラリとスクリプトをダウンロードしてインストールします。

COTを使用した Cisco Catalyst 8000Vの基本的なプロパティの編集
COTを使用して Cisco Catalyst 8000Vを展開する前に、COTを使用して OVAパッケージの
Cisco Catalyst 8000V VMの基本プロパティまたはカスタムプロパティを編集できます。

OVAの基本プロパティを編集するには、cot edit-propertiesコマンドを使用します。

cot edit-properties

-p key1=value1, --properties key1=value1

このコマンドは、キーと値のペアを使用してプロパティを設定します。たとえば、-p
"login-username=cisco"は、キーと値のペアを使用してログインユーザー名を設定します。

-o output

既存の OVAを更新する代わりに新しい OVAを作成する場合は、新しい OVAパッケージの名
前またはパスを指定します。

cot edit-propertiesコマンドの詳細については、
http://cot.readthedocs.io/en/latest/usage_edit_properties.htmlを参照してください。

COTを使用した Cisco Catalyst 8000Vの基本プロパティの編集（サンプル）

cot edit-properties c8000v-universalk9.ova
-p "login-username=cisco"

-p "login-password=cisco"
-o c8000v-universalk9-customized.ova
\# save modifications to a new OVA
cot info c8000v-universalk9-customized.ova
# verify the new values of properties in the OVA

(...)
Properties:
<config-version> "1.0"
Router Name ""
Login Username "cisco"
Login Password "cisco"
Management Interface "GigabitEthernet1"
Management VLAN ""
Management Interface IPv4 Address/Mask ""

次の表に、上記の例で使用される cot edit-propertiesコマンドと引数を示します。
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説明スクリプトステップ

OVAファイルの基本的な環境プロパティを編集しま
す。

cot edit propertie
s c8000v-universalk9.ova

ブートストラップログインユーザー名を設定します。
-p "login-username=cisco"

ブートストラップログインパスワードを設定します。
-p "login-password=cisco"

テキストファイルからの設定コマンドを含む、変更さ

れた OVAを保存します。
-o
"c8000v-universalk9-customized.ova"

カスタムプロパティの編集

vSphere GUIを使用して、Cisco IOS XE CLIコマンドに基づくカスタム属性を Cisco Catalyst
8000Vインスタンスに追加できます。Cisco Catalyst 8000Vインスタンスの起動前または後に、
これらのプロパティを追加できます。CiscoCatalyst 8000Vインスタンスの起動後にこれらのカ
スタム属性を設定した場合、プロパティ設定を有効にするには、ルータをリロードするか、

VMの電源を再投入する必要があります。

vAppオプションを編集してカスタム Cisco Catalyst 8000Vプロパティを追加するには、以下の
手順を実行します。

ステップ 1 vSphere GUIで [Options]タブを選択します。

ステップ 2 [vApp Options] > [Advanced]を選択します。

ステップ 3 [Advanced Property Configuration]画面で、[Properties]ボタンをクリックします。

ステップ 4 プロパティを追加するには、[New]をクリックします。

ステップ 5 [Edit Property Settings]画面で、Cisco IOSXECLIコマンドに基づく新しいカスタムプロパティを作成するた
めの情報を入力します。

カスタムプロパティを追加する前に、カスタムプロパティの基になる Cisco IOS XEコマンドが、使
用中の Cisco Catalyst 8000Vバージョンでサポートされていることを確認します。

（注）

a) （任意）ラベルを入力します。これはプロパティを説明する文字列です。
b) クラス IDとして「com.cisco.c8000v」と入力します。
c) ID「ios-config-xxxx」をプロパティに割り当てます。「xxxx」は、カスタムプロパティを適用する順序
を決定する 0001～ 9999のシーケンス番号です。

d) （任意）プロファイルの説明を入力します。
e) プロパティタイプとして「string」と入力します。これは、サポートされる唯一のタイプです。
f) デフォルト値として、カスタムプロパティが基にする Cisco IOS XE CLIコマンドを入力します。

ステップ 6 [OK]をクリックします。

ステップ 7 [Advanced Property Configuration]画面で、[OK]をクリックします。

ステップ 8 Cisco Catalyst 8000Vインスタンスを再起動します。

VMware ESXi環境でのインストール
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新規または編集されたプロパティを有効にするには、ルータを再起動する必要があります。

cot edit-properties
少数の設定コマンドを OVAに事前適用するには、cot edit-propertiesコマンドを使用します。

もっと多くのコマンドを使用するには、cot inject-configコマンドを使用します。

cot edit-propertiesコマンドの詳細については、
http://cot.readthedocs.io/en/latest/usage_edit_properties.htmlを参照してください。

概要と説明

cot edit-properties ova-filename

-o output

既存の OVAを更新する代わりに新しい OVAを作成する場合は、新しい OVAパッケージの名
前またはパスを指定します。

-c config-file

OVAに追加する IOS XEコマンドを含むテキストファイルの名前を指定します。

例

この例では、以前に作成されたテキストファイル iosxe_config.txt（IOS XE configコマンドを含
む）が、cot edit-propertiesコマンドを使用してOVAに追加されます。最後に、cot infoコマン
ドを使用して、変更された OVAを表示します。

$ cat iosxe_config.txt

interface GigabitEthernet1
no shutdown
ip address 192.168.100.10 255.255.255.0
!
ip route 0.0.0.0 0.0.0.0 GigabitEthernet1 192.168.100.1
$ cot edit-properties c8000v-universalk9.ova \

-o c8000v-universalk9-customized.ova \
-c iosxe_config.txt

$ cot info c8000v-universalk9-customized.ova

...

Properties:
<config-version> "1.0"
Router Name ""

...

Intercloud Tunnel Interface Gateway IPv4 Address ""
<ios-config-0001> "interface GigabitEthernet1"
<ios-config-0002> "no shutdown"
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<ios-config-0003> "ip address 192.168.100.10 255.255.255.0"
<ios-config-0004> "ip route 0.0.0.0 0.0.0.0 GigabitEthernet1 192.168.100.1"

次の表に、この例で使用する cot edit propertiesコマンドと引数を示します。

説明スクリプトステップ

OVAファイルのカスタム環境プロパティを編集しま
す。

cot edit properties
c8000v-universalk9.ova

テキストファイルからの設定コマンドを含む新しい

OVA。
-o
"c8000v-universalk9-customized.ova"

IOS XE設定コマンドを含むテキストファイル。この
ファイルに含まれる各行の設定により、OVFの XML
で com.cisco.productname.ios-config-xxxxなどのエントリ
が生成されます。

-c iosxe_config.txt

cot inject-config
OVAに事前適用する設定コマンドが多数ある場合は、cot inject-configコマンドを使用します。
たとえば、完全な実行コンフィギュレーションを追加する場合に使用します。このコマンド

は、設定コマンドに（XMLの代わりに）プレーンテキストを使用するため、ファイルサイズ
とロード時間の点で効率的です。cot inject-configコマンドの詳細については、
http://cot.readthedocs.io/en/latest/usage_inject_config.htmlを参照してください。

概要と説明

cot inject-config ova-filename

-o output

既存の OVAを更新する代わりに新しい OVAを作成する場合は、新しい OVAパッケージの名
前またはパスを指定します。

-c config-file

OVAに埋め込むテキストファイルの名前（iosxe_config.txtなど）を指定します。

例

この例では、cot inject-configコマンドがテキストファイル iosxe_config.txtの Cisco IOS XEコ
マンドを OVAに追加します。

$ cat iosxe_config.txt
interface GigabitEthernet1
no shutdown
ip address 192.168.100.10 255.255.255.0
!
ip route 0.0.0.0 0.0.0.0 GigabitEthernet1 192.168.100.1
$ cot inject-config c8000v-universalk9.ova \

-o c8000v-universalk9-customized.ova \
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-c iosxe_config.txt
$ cot info c8000v-universalk9-customized.ova

<..簡潔にするために、その他の出力が省略されています..>

Files and Disks: File Size Capacity Device
--------- --------- --------------------

c8000v_harddisk.vmdk 71.50 kB 8.00 GB harddisk @ SCSI 0:0
bdeo.sh 52.42 kB
README-OVF.txt 8.53 kB
README-BDEO.txt 6.75 kB
cot.tgz 116.78 kB
c8000v-universalk9.iso 484.80 MB cdrom @ IDE 1:0
config.iso 350.00 kB cdrom @ IDE 1:1

次の表に、この例で使用する cot inject-configコマンドと引数を示します。

説明スクリプトステップ

OVAファイルのカスタム環境プロパティを編集しま
す。

cot inject-config
c8000v-universalk9.ova

テキストファイルからの configコマンドを含む、新規
または変更された OVAの名前。

-o
"c8000v-universalk9-customized.ova"

IOSXE設定コマンドを含むテキストファイルの名前。
-c iosxe_config.txt

COTを使用した Cisco Catalyst 8000V VMの展開
Cisco Catalyst 8000V VMを展開するには、次の手順に示すように cot deploy ... esxiコマンドを
使用します。以下の説明は一般的なガイダンスを示していることに注意してください。実行す

る必要のある正確な手順は、VMware環境と設定の特性に応じて異なる場合があります。

cot deploy ... esxiコマンドを実行して Cisco Catalyst 8000Vを展開します。スクリプトオプションについて
は、http://cot.readthedocs.io/en/latest/usage_deploy_esxi.htmlを参照してください。

デフォルト値は、Cisco Catalyst 8000Vのバージョンによって異なります。（注）

例

次の表に、vCenter環境での Cisco Catalyst 8000V VMの展開に使用する cot deployコマンドと
その引数の例を示します。

説明スクリプトステップ

cot deploy
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説明スクリプトステップ

vCenterサーバー 10.122.197.5、ターゲットホ
スト UCS/ホスト/10.122.197.38

-s '10.122.197.5/UCS/host/10.122.197.38'

ESXiサーバーのログイン情報。指定しない場
合、COTはユーザー IDを使用し、パスワー
ドの入力を求めます。

-u administrator -p password

新しく作成された Cisco Catalyst 8000V VMの
名前。

-n XE3.13

OVFハードウェア設定プロファイル。これが
指定されていない場合、COTは使用可能なプ
ロファイルのリストを表示し、プロファイル

を選択するように求めます。

-c 1CPU-4GB

Cisco Catalyst 8000V OVAの各NICをサーバー
の vSwitchにマッピングします。

-N "GigabitEthernet1=VM Network"
-N "GigabitEthernet2=VM Network"
-N "GigabitEthernet3=VM Network"

ターゲットハイパーバイザ（現在は常に

ESXi）
esxi

展開する OVA
~/Downloads/c8000v-universalk9.ova

ESXi固有のパラメータ（ここでは、ディスク
ストレージ用に使用するデータストア）。

-ds=datastore38a

.isoファイルを使用した VMの手動作成
以下の手順に従って、VMware ESXiホストに .isoファイルをインストールし、vSphere GUIを
使用して手動でVMを作成します。この手順には、Cisco Catalyst 8000Vの展開に関する一般的
なガイドラインが記載されていますが、実行する必要がある正確な手順は、使用中のVMware
環境と設定の特性によって異なる可能性があります。この手順に含まれる指示は、VMware
ESXi 5.0に基づいています。

ステップ 1 Cisco Catalyst 8000Vソフトウェアインストールイメージパッケージから C8000V_esxi.isoファイルをダ
ウンロードし、VMデータストアにコピーします。

ステップ 2 vSphereクライアントで、[Create a New Virtual Machine]オプションを選択します。

ステップ 3 [Configuration]で、カスタム設定を作成するオプションを選択して [Next]をクリックします。

ステップ 4 [Name and Location]で、VMの名前を指定して [Next]をクリックします。

ステップ 5 [Storage]で、VMに使用するデータストアを選択します。[Next]をクリックします。
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ステップ 6 [VirtualMachine Version]フィールドで、[VirtualMachine Version 15]またはそれ以降の使用可能なバージョ
ンを選択します。[Next]をクリックします。

Cisco Catalyst 8000Vには、6.5 Update 2より前のバージョンの ESXiサーバーとの互換性がありま
せん。

（注）

ステップ 7 [Guest Operating System]で、[Linux]を選択し、ドロップダウンメニューから [Other 3.x Linux (64-bit)]設
定を選択します。[Next]をクリックします。

ステップ 8 [CPU]の下で、次の設定を選択します。

•仮想ソケット（仮想 CPU）の数

•ソケットあたりのコア数

ソケットごとのコアの数は、選択されている仮想ソケットの数に関係なく、常に [1]に設定する必要があ
ります。たとえば、4 vCPU構成の Cisco Catalyst 8000Vでは 4ソケット、ソケットあたり 1コアとして設
定する必要があります。

[Next]をクリックします。

ステップ 9 [Memory]で、Cisco Catalyst 8000Vリリースでサポートされるメモリサイズを設定します。[Next]をク
リックします。

ステップ 10 [Network]で、少なくとも 3つの仮想ネットワークインターフェイスカード（vNIC）を割り当てます。

a) 接続する vNICの数をドロップダウンメニューから選択します。

VMware ESXiインターフェイスでは、最初の VMの作成中は、vNICを 4個だけ作成できま
す。VMが作成され、Cisco Catalyst 8000Vを最初に起動した後に、vNICをさらに追加できま
す。

（注）

b) vNICを追加します。

各 vNICに異なるネットワークを選択します。

ドロップダウンメニューからアダプタタイプを選択します。使用中のリリースでサポートされてい

るアダプタタイプについては、本ガイドの要件のセクションを参照してください。

c) すべての vNICを選択して電源投入時に接続します。
d) [Next]をクリックします。

CiscoCatalyst 8000Vの実行中に、vSphereを使用して vNICをVMに追加することができます。
既存の VMに vNICSを追加する方法の詳細は、vSphereのマニュアルを参照してください。

（注）

ステップ 11 [SCSI Controller]で、[VMware Paravirtual]を選択します。[Next]をクリックします。

ステップ 12 [Select a Disk]で、[Create a New Virtual Disk]をクリックします。

ステップ 13 [Create a Disk]フィールドで、以下の項目を設定します。

a) [Capacity: Disk Size]：使用中のリリースで必要な仮想ハードディスクサイズについては、本ガイドの
要件のセクションを参照してください。

b) [Disk Provisioning]：[Thick Provision Lazy Zeroed]または [Thick Provision Eager Zeroed]のいずれかを選
択します。
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[Thin Provision]オプションはサポートされていません。[Thick Provision Eager Zeroed]オプショ
ンを指定すると、インストールにかかる時間が長くなりますが、優れたパフォーマンスが得

られます。

（注）

c) [Location]：仮想マシンと同じ場所に保存します。

[Next]をクリックします。

ステップ 14 [Advanced Options]フィールドで、仮想デバイスノード用に [SCSI (0:0)]を選択します。

ステップ 15 [Ready to Complete]画面で、完了前の [Edit the Virtual Machine]設定をクリックします。[Continue]チェッ
クボックスをオンにします。

ステップ 16 [Hardware]タブで、[New CD/DVD Drive]をクリックします。

a) VMの起動元の [Device Type]を選択します。

.isoファイルから起動する [Datastore ISO file]オプションを選択します。ステップ 1で設定したデー
タストア上の .isoファイルの場所を参照します。

b) [Device Status]フィールドで、[Connect at Power On]チェックボックスをオンにします。
c) VMを起動するホスト上の [Virtual Device Node CD/DVD]ドライブを選択します。

ステップ 17 [Resources]タブで、[CPU]設定をクリックします。

[Resource Allocation]設定を [Unlimited]に設定します。

ステップ 18 [OK]をクリックします。

ステップ 19 [Finish]をクリックします。

Cisco Catalyst 8000V用のVMが設定され、起動する準備が整いました。VMの電源がオンになると Cisco
Catalyst 8000Vが起動されます。「Booting the Cisco Catalyst 8000V VM and Accessing the Console」のセク
ションを参照してください。

手動でインストールした Cisco Catalyst 8000Vにデイゼロを設定するには、上記のブートストラッ
プ設定を含む ISOをポイントする 2番目の CD/DVDドライブを接続します。サポートされている
ブートストラップ ISOの内容の詳細については、デイゼロ設定を参照してください。

（注）

仮想VGAコンソールの代わりに ESXiホストのシリアルポートから Cisco Catalyst 8000Vにアクセ
スして設定する場合は、VMの電源をオンにしてルータを起動する前に、この設定を使用するよ
う VMをプロビジョニングします。

（注）

VMware ESXi構成でのパフォーマンスの向上
ホストと仮想マシンの設定を変更することで、ESXi環境で実行される Cisco Catalyst 8000Vの
パフォーマンスを向上させることができます。

•ハイパーバイザのパフォーマンス設定を有効にします。
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https://www.cisco.com/c/en/us/td/docs/routers/C8000V/Configuration/c8000v-installation-configuration-guide/m_booting_cisco_csr.html
c8000v-installation-configuration-guide_chapter9.pdf#nameddest=unique_13


•サポートされている物理 NICで SR-IOVを有効にして、vSwitchのオーバーヘッドを制限
します。

•物理 NICと同じ NUMAノードで動作するように VMの vCPUを設定します。

• [VM Latency Sensitivity]を [High]に設定します。

VMwareバージョン 6.7および 6.5でのベストプラクティスの詳細については、
https://www.vmware.com/content/dam/digitalmarketing/vmware/en/pdf/techpaper/performance/Perf_
Best_Practices_vSphere65.pdfと https://www.vmware.com/techpapers/2019/
vsphere-esxi-vcenter-server-67U2-performance-best-practices.htmlを参照してください。

ホスト設定の変更

VMware ESXi設定のパフォーマンスを向上させるには、ホスト設定で次の変更を行います。

• [Power Management]で [High Performance]オプションを選択します。

• [Hyperthreading]を無効にします。

•サポートされている物理アダプタの SR-IOVを有効にします。

仮想マシン設定の変更

VMware ESXi設定のパフォーマンスを向上させるには、ホスト設定で次の変更を行います。

• ESXiバージョンが使用中の Cisco Catalyst 8000Vバージョンと互換性があることを確認し
ます。

• [Virtual Hardware: CPU]の予約を [Maximum]に設定します。

• [Virtual Hardware: Memory]ですべてのゲストメモリを予約します。

• [Virtual Hardware: SCSI Controller]から [VMware Paravirtual]を選択します。

• [Virtual Hardware: NetworkAdapter: Adapter Type]オプションから、サポートされているNIC
の SR-IOVを選択します。

• [General Guest OS Version] > [VM Options]オプションを [Other 3.x or later Linux (64-bit)]に
設定します。

• [Advanced Latency Sensitivity]の [VM Options]オプションを [High]に設定します。

• [VM Options] > [Advanced Edit Configuration]で、「numa.nodeAffinity」を SRIOV NICと同
じ NUMAノードに追加します。

VMware ESXi環境でのインストール
21

VMware ESXi環境でのインストール

VMware ESXi構成でのパフォーマンスの向上

https://www.vmware.com/content/dam/digitalmarketing/vmware/en/pdf/techpaper/performance/Perf_Best_Practices_vSphere65.pdf
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https://www.vmware.com/techpapers/2019/vsphere-esxi-vcenter-server-67U2-performance-best-practices.html
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翻訳について
このドキュメントは、米国シスコ発行ドキュメントの参考和訳です。リンク情報につきましては
、日本語版掲載時点で、英語版にアップデートがあり、リンク先のページが移動/変更されている
場合がありますことをご了承ください。あくまでも参考和訳となりますので、正式な内容につい
ては米国サイトのドキュメントを参照ください。


